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Apresentação 

 

O Inventário Florestal Nacional (IFN-BR) visa fundamentar a formulação e implementação de 

políticas públicas de desenvolvimento, uso e conservação dos recursos florestais, bem como a gestão 

desses recursos, por meio de informações suficientes, confiáveis e periodicamente atualizadas, 

coletadas a campo. Estudos em escala de paisagem, por sua vez, também têm adquirido importância 

fundamental dentro desse contexto, por permitirem a avaliação da dinâmica de uso e cobertura da 

terra e das interações entre padrões espaciais e processos ecológicos, envolvendo florestas e outros 

usos da terra, como a agricultura.  

Por sua vez, a Política Nacional de Meio Ambiente no Brasil tem por objetivo a preservação, 

melhoria e recuperação da qualidade ambiental propícia à vida, visando assegurar, no país, condições 

ao desenvolvimento socioeconômico, aos interesses da segurança nacional e à proteção da dignidade 

da vida humana. Dessa maneira, o objetivo geral da Política Nacional do Meio Ambiente está dividido 

em preservação, melhoramento e recuperação do meio ambiente. Para poder implementar ações 

relativas a tais objetivos requer-se instrumentos de diagnóstico e análise que permitam mapear e 

avaliar ecossistemas e os respectivos serviços que proveem em seus territórios, ambos espacialmente 

explícitos. Daí advém à necessidade de incluir dados e indicadores espaciais na análise. Nessa 

avaliação, torna-se também necessário traduzir o resultado de abordagens técnico-científicas em 

informação compreensível para a implementação de políticas públicas e tomada de decisão, o que 

pode ser feito por meio de mapas, indicadores, relatórios e gráficos. 

Assim, a Embrapa Florestas desenvolveu, em conjunto com o Serviço Florestal Brasileiro (SFB) 

e com o suporte do BID (Banco Interamericano de Desenvolvimento), uma metodologia para a análise 

espacial da estrutura da paisagem no contexto do IFN-BR. O objetivo do denominado Componente 

Geoespacial dentro do projeto do IFN-BR, ao longo das diferentes edições, é observar a dinâmica de 

uso das florestas por meio de imagens orbitais, em escalas compatíveis com os interesses nacionais e 

estaduais e utilizando, para tanto, indicadores como mudanças no uso da terra e fragmentação 

florestal. De tal maneira, pretende-se produzir informações sobre a importância e qualidade dos 

recursos florestais em relação a outros usos da terra, em escala de paisagem, ressaltando suas funções, 

qualidade e pressões incidentes, de modo a subsidiar a formulação de políticas públicas que sejam 

apropriadas à região e à sua escala de abordagem.  

A análise da paisagem complementa outros dois componentes do IFN-BR, a coleta de dados 

em campo e o levantamento socioeconômico, além de ser destinada ao monitoramento do 
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componente florestal em escala de paisagem ao longo do tempo. Nesse contexto estão inseridas as 

chamadas Unidades Amostrais de Paisagem (UAPs), por meio das quais é implementado o 

Componente Geoespacial do IFN-BR, concebidas para oferecer um ferramental que permita ao usuário 

a visualização de aspectos da paisagem conjugados sob a forma de indicadores e seus respectivos 

índices. As UAPs são áreas amostrais permanentes de 100 km², distribuídas sistematicamente em um 

grid de 40 x 40 km sobre todo o território nacional, perfazendo um total de aproximadamente 5.500 

unidades. Todas contêm uma Unidade Amostral de Campo do IFN-BR, na forma de um conglomerado, 

localizada em seu centro geométrico. Dessa maneira, a estratégia adotada foi desenvolver a 

metodologia de todos os componentes do IFN-BR com vistas à sua integração e posterior análise 

conjunta. 

Uma vez que proporcionam a possibilidade tanto de análises estáticas - em apenas uma data 

-, quanto dinâmicas - quando os índices são calculados para sucessivas ocasiões -, as UAPs constituem 

unidades de diagnóstico e de monitoramento. A base para o cálculo dos índices de paisagem e 

posteriores análises é o mapa de uso e cobertura da terra, obtido empregando-se processos de 

classificação e análise de imagens orientada a objetos. Assim, os indicadores e índices de paisagem 

permitem estabelecer um diagnóstico integrado de cada UAP, que, por sua vez, reflete uma 

determinada combinação de características biogeoclimáticas (classe territorial ou ecorregião), 

associadas a fatores de influência antrópicos ou naturais, ocorrentes naquela localidade. 

Apesar da utilização de técnicas sofisticadas para o mapeamento temático, algumas limitações 

ainda são encontradas, de forma que nas classificações decorrentes de processos automatizados, 

como é o caso da metodologia utilizada na elaboração dos mapas de uso e cobertura da terra nas UAPs 

do IFN-BR, erros resultantes de interações complexas entre as estruturas espaciais da paisagem, a 

resolução do sensor, os algoritmos de pré-processamento e os procedimentos da própria classificação 

podem ocorrer (Campbell, 1996). Assim, a qualidade dos mapas de uso e cobertura da terra, utilizados 

para a análise de paisagem do IFN-BR, deve ser conhecida, tendo em vista que o cálculo dos 

indicadores e índices de paisagem deriva diretamente deste produto. A qualidade dos resultados 

gerados pelos índices de paisagem está diretamente atrelada à qualidade dos mapas de uso e 

cobertura da terra.  
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1 VALIDAÇÃO DOS MAPAS DE USO E COBERTURA DA TERRA 

A validação de um mapa de uso e cobertura da terra refere-se a um conjunto de técnicas 

necessárias à determinação da sua qualidade, que se divide em três pontos principais: o desenho 

amostral, a estratégia de verificação e o protocolo de análise e estimativa dos resultados (Stehman e 

Czaplewski, 1998). Inclui a avaliação da acurácia por meio da comparação entre os resultados da 

imagem classificada e outras fontes de informação, em observações baseadas em um desenho 

amostral probabilístico, permitindo a estimativa da acurácia global, da acurácia do produtor e do 

usuário e dos erros de omissão e comissão (Strahler et al., 2006). A avaliação da acurácia é um requisito 

básico no processo de elaboração e distribuição de mapas temáticos e uma condição necessária para 

a comparação de resultados e o uso dos produtos de um mapeamento (Stehman e Wickham, 2011; 

Radoux e Bogaert, 2017). Unidades amostrais verificadas em campo ou em imagens de melhor escala 

espacial permitem quantificar a qualidade dos resultados gerados (Stehman e Czaplewski, 1998; 

Stehman, 2009).  

Muito se discute sobre recomendações a serem adotadas para a avaliação da qualidade de 

classificações temáticas, sobretudo quando a análise orientada a objetos é adotada. De acordo com 

Radoux e Bogaert (2017), as boas práticas de avaliação da acuracidade temática envolvendo a 

avaliação de matrizes de erro descritas por Olofsson et al. (2014) e Strahler et al.(2006) podem ser 

adotadas em muitos dos casos, mesmo quando a segmentação de imagens e a classificação orientada 

a objetos é utilizada. As boas práticas de Olofsson et al. (2014) também são adotadas no guia prático 

elaborado por Finegold (2016), publicado pela FAO, e serão seguidas neste trabalho.  

Olofsson et al. (2014) recomendam que a avaliação da acurácia leve em consideração a 

proporção de área com base na amostragem dos pontos de referência. As boas práticas incluem: 

i) a implementação de um desenho amostral probabilístico selecionado para atingir os 

objetivos prioritários da estimativa de área e de acurácia ao mesmo tempo em que existem 

restrições práticas como os custos e a disponibilidade de fontes de referências; 

ii) a implementação de um protocolo de verificação baseado em fontes de dados de referência 

que forneçam informações suficientemente detalhadas em termos de resolução espacial e 

temporal para a correta rotulagem de cada unidade amostral; 

iii) a implementação de uma forma de análise consistente com o desenho amostral e o 

protocolo de verificação; 
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iv) sumarização da avaliação da acurácia por meio da matriz de erros em termos da proporção 

de área e estimativa da acurácia global, acurácia do usuário (ou erro de comissão) e acurácia 

do produtor (ou erro de omissão); 

v) estimativa da área por classe baseada na classificação das unidades amostrais de 

referência; 

vi) quantificação da incerteza pela inclusão do intervalo de confiança para os parâmetros de 

acurácia e área; 

vii) avaliação da variabilidade e do erro potencial na referência da classificação; 

viii) documentação dos desvios das boas práticas que podem substancialmente afetar os 

resultados.  

 

A seguir são apresentados os conceitos básicos adotados em consonância com as boas práticas 

propostas por Olofsson et al. (2014) e os procedimentos necessários para a validação do mapeamento 

de uso e cobertura da terra.  

 

1.1. Desenho Amostral 

O desenho amostral consiste no protocolo para a seleção de unidades amostrais, sendo que a 

recomendação mais crítica é a de que as amostras sejam selecionadas de forma randômica onde a 

probabilidade de inclusão de cada amostra seja conhecida e maior do que zero para cada uma das 

unidades amostrais (Olofsson et al., 2014).  

No caso das unidades amostrais de paisagem do IFN-BR, foi selecionada a amostragem 

sistemática por meio de um grid de pontos equidistantes entre si em 500m. A unidade amostral é 

definida pelo pixel onde o ponto se encontra, tendo área igual à do pixel, ou seja, 25m2. Considera-se 

este formato apropriado ao componente Geoespacial do IFN-BR, pois confere padronização, bastante 

desejável em um inventário nacional dada a necessidade de atuação de diferentes profissionais na 

elaboração dos produtos e a sistematização dos procedimentos. A implementação do grid e a 

interpretação dos pontos neste modelo é prática e pode ser realizada em menor tempo do que quando 

amostras são distribuídas de forma aleatória ou estratificada.  

A representatividade amostral deste tipo de grid foi comprovada quando experimentos 

elaborados com diferentes densidades de pontos foram avaliados, incluindo redes de pontos 

equidistantes com 100m, 250m, 500m, 750m e 1000m, em comparação com uma interpretação visual 
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e avaliação de todos os pixels da imagem, ou seja, um censo. A partir de 500m, percebeu-se que o 

adensamento do grid não mais contribui para a melhoria na estimativa da acurácia da classificação. 

Outro aspecto observado é que de maneira geral, para um grid com pontos equidistantes a 500m, a 

proporção da área das classes na UAP reflete-se na proporção da área dos pontos de referência por 

classe.  

A seleção sistemática de unidades amostrais é capaz de fornecer estimativas mais precisas do 

que a seleção randômica simples e o desenho amostral sistemático é bastante apropriado para 

inventários florestais nacionais, já que as amostras de campo seguem a mesma configuração, o que 

permitiria a coleta de informações durante as campanhas de campo para a validação da imagem 

classificada (Olofsson et al., 2014).  

 

1.2. Estratégia de Verificação  

No contexto da avaliação de acurácia, a estratégia de verificação compreende todos os 

aspectos do protocolo que determinam a concordância entre a classe atribuída à unidade amostral na 

imagem classificada e a mesma área na referência. Os principais elementos da estratégia de verificação 

são as dimensões da unidade amostral, a fonte de informações utilizada como referência, o protocolo 

de rotulagem e as definições de concordância entre as classificações da imagem e da referência 

(Olofsson et al., 2014). As características destes elementos no âmbito do Componente Geoespacial no 

IFN-BR serão apresentadas a seguir.  

A menor dimensão para uma unidade amostral e a mais comumente adotada na maioria das 

estratégias para avaliação da acuracidade temática de imagens classificadas é o pixel, sendo bastante 

conhecidos os protocolos e as formas de análise associadas com a implementação de uma amostragem 

baseada em pixels (Stehman e Wickham, 2011). A utilização de polígonos como unidades amostrais 

apresenta alguns problemas práticos. A possibilidade de ocorrência de múltiplas classes de uso e 

cobertura em um mesmo polígono, por exemplo, leva à subjetividade na definição do percentual de 

ocorrência de cada classe. A necessidade de avaliação das diferenças entre os limites do polígono de 

referência e da imagem por meio do delineamento manual também leva à subjetividade. Por tratar-se 

de um inventário florestal nacional, a sistematização é necessária, buscando-se protocolos que 

permitam a operacionalização e a padronização de processos. Considerando-se que a segmentação da 

imagem é um processo padronizado por um algoritmo que define automaticamente, para cada 

imagem, o fator de escala a ser adotado e que as imagens utilizadas são ortorretificadas e tiveram sua 
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acurácia posicional avaliada (Costa et al., 2015), não serão realizadas avaliações dos limites dos 

polígonos. O algoritmo implementado define o fator de escala pelo incremento deste parâmetro de 

forma iterativa, otimizando a homogeneidade espectral e o tamanho dos polígonos, até que a maioria 

absoluta dos polígonos (90%) tenha área maior ou igual à unidade mínima de mapeamento (500m2), 

levando em conta a similaridade espectral, conforme definido no Manual de Execução do Uso e 

Cobertura da Terra do IFN-BR.  

A impossibilidade de visitas a campo com maior densidade do que a já praticada pelo 

levantamento realizado pelo IFN-BR e pela necessidade de intensificação dos pontos amostrais para a 

avaliação da acurácia da classificação das Unidades Amostrais de Paisagem torna necessária a seleção 

de fonte de referência alternativa. A primeira fonte de dados de referência consiste no próprio mosaico 

das imagens RapidEye (RE), utilizado para a elaboração do mapa de uso e cobertura. Porém, dados de 

maior resolução espacial e temporal devem ser utilizados como fonte de referência complementar às 

imagens RapidEye, tendo-se selecionado as imagens do Google Earth para tal finalidade. Desta forma, 

é válido o tipo de uso e cobertura interpretado a partir das imagens RapidEye, utilizando-se as imagens 

Google Earth como um apoio na interpretação do contexto no qual a unidade amostral em avaliação 

está inserida. Além de estarem disponíveis para praticamente todo o país, têm melhor qualidade para 

a interpretação visual pois a resolução espacial é maior e a resolução temporal permite a análise de 

informações pretéritas, essenciais em algumas classes de uso do solo, como os plantios florestais, por 

exemplo. Desta forma, uma densidade de aproximadamente 500 pontos pode ser levantada 

rapidamente e com grande riqueza de informações auxiliares. A cobertura, no entanto, não está 

disponível em alta resolução e com séries históricas para todo o país, porém segue sendo a melhor 

alternativa, já que uma apenas uma pequena percentagem tem cobertura deficiente. A utilização desta 

fonte de informação tem sido amplamente adotada nos últimos anos e consta das boas práticas citadas 

por Olofsson et al. (2014). Uma prática recomendada pelos autores quando imagens do Google Earth 

são utilizadas é a data de aquisição das cenas, que consta na parte inferior da tela. A data mais próxima 

possível da data de aquisição da(s) imagem(s) RapidEye utilizada(s) para a elaboração do mosaico deve 

ser preferida.  

O ponto central de cada UAP contém uma unidade amostral de campo do IFN-BR, onde 

valiosas informações são coletadas, incluindo fotografias da unidade amostral de campo e arredores. 

Estes dados devem ser utilizados para a interpretação do uso e cobertura da terra, principalmente os 

tipos de vegetação que ocorrem na área. A estratégia de rotulagem das classes de uso e cobertura da 

terra deve seguir a classificação e a descrição fornecida pelo IFN-BR e completamente descrita no 

Manual de Execução do Uso e Cobertura da Terra do IFN-BR. O sistema de classificação de uso e 
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cobertura da terra da FAO foi adotado e compatibilizado com o sistema oficial de classificação da 

vegetação brasileira do IBGE (IBGE, 2012). O processo de rotulagem da referência e a sua comparação 

com os resultados da classificação não é tarefa trivial, já que muitas definições para os diferentes tipos 

de uso e cobertura podem ser adotadas, e o sistema da FAO facilita esta transição (Ahlqvist, 2008).  

 

1.3. Análise e Estimativa dos Resultados 

Esta etapa inclui os protocolos de como quantificar a acurácia, a formulação e a abordagem de 

inferência a serem adotadas para a estimativa da acurácia e da área e a quantificação da incerteza 

destas estimativas. A matriz de erros tem papel principal nesta etapa (Olofsson et al., 2014). 

As matrizes de erro são o meio mais comum de se expressar a acuracidade de uma classificação 

temática (Rosot, 2001; Foody, 2002), fornecendo a base para descrever a precisão da classificação e 

caracterizar os erros, ajudando a refinar a classificação ou estimativas que possam derivar dessa 

(Foody, 2002; Figueiredo e Vieira, 2007). Tais matrizes comparam, classe a classe, a relação entre os 

dados de referência conhecidos e os respectivos resultados de uma classificação automática (Lillesand 

e Kiefer, 1994).  

A matriz de erro é uma matriz quadrada, de dimensão q x q, onde q é o número de classes. Os 

elementos da matriz apresentam o número de pontos que representam uma classe da imagem 

classificada “𝑖” e da verdade de campo “𝑗” (𝑛𝑖𝑗), amostrados para cada classe. Nas linhas se encontram 

o número de pontos amostrais de cada classe segundo a classificação automática e nas colunas aqueles 

da referência. Dessa forma, a diagonal principal da matriz conterá o número de pixels classificados 

corretamente para cada categoria, enquanto as células fora da diagonal apresentam os erros de 

omissão e comissão (Tabela 1). A partir dessa matriz, a avaliação da acurácia pode ser obtida por meio 

de coeficientes de concordância, que podem ser expressos como concordância total ou para classes 

individuais (Lillesand e Kiefer, 1994).  
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Tabela 1. Matriz de erro, onde os elementos em destaque representam a diagonal principal da matriz que contém 
os casos em que a classe representada na classificação da imagem e os pontos de controle 
representando a verdade de campo coincidem, enquanto os elementos fora desta diagonal 
contemplam os casos em que existe divergência entre esses. (Fonte: Adaptado de Foody, 2002). 

  Referência 

C
la

ss
if

ic
aç

ão
 

 A B C D Σ 

A 𝒏𝑨𝑨 𝑛𝐴𝐵 𝑛𝐴𝐶  𝑛𝐴𝐷 𝑛𝐴+ 

B 𝑛𝐵𝐴 𝒏𝑩𝑩 𝑛𝐵𝐶  𝑛𝐵𝐷 𝑛𝐵+ 

C 𝑛𝐶𝐴 𝑛𝐶𝐵 𝒏𝑪𝑪 𝑛𝐶𝐷 𝑛𝐶+ 

D 𝑛𝐷𝐴 𝑛𝐷𝐵 𝑛𝐷𝐶 𝒏𝑫𝑫 𝑛𝐷+ 

Σ 𝑛+𝐴 𝑛+𝐵 𝑛+𝐶 𝑛+𝐷 𝑛 

 

A contagem absoluta do número de pixels na amostra 𝑛𝑖𝑗 (Figura 11) pode ser convertida na 

proporção de área estimada 𝑝̂𝑖𝑗 (Tabela 2) com a Equação 1, quando o estrato corresponde às classes 

do mapa quando a amostragem aleatória simples, sistemática simples ou estratificada aleatória é 

utilizada. Desta forma, os valores na matriz de erros representam a proporção da área e não a 

contagem de pixels (Tabela 2).  

 
𝑝̂𝑖𝑗 = 𝑊𝑖  

𝑛𝑖𝑗

𝑛𝑖
 

Equação 1 

Em que: 

𝑊𝑖   = proporção de área classificada como classe 𝑖 e que pode ser calculada pela divisão do 
número de pixels por estrato pelo número de pixels da UAP; 

 

Tabela 2. Matriz de erro para quatro classes, onde as entradas das células (𝒑𝒊𝒋) representam a proporção da área 

da população (amostra) que tem classe da imagem classificada 𝒊 e classe da referência 𝒋 

  Referência 

C
la

ss
if

ic
aç

ão
 

 Classe 1 Classe 2 Classe 3 Classe 4 Total 

Classe 1 𝒑𝟏𝟏 𝒑𝟏𝟐 𝒑𝟏𝟑 𝒑𝟏𝟒 𝒑𝟏. 

Classe 2 𝒑𝟐𝟏 𝒑𝟐𝟐 𝒑𝟐𝟑 𝒑𝟐𝟒 𝒑𝟐. 

Classe 3 𝒑𝟑𝟏 𝒑𝟑𝟐 𝒑𝟑𝟑 𝒑𝟑𝟒 𝒑𝟑. 

Classe 4 𝒑𝟒𝟏 𝒑𝟒𝟐 𝒑𝟒𝟑 𝒑𝟒𝟒 𝒑𝟒. 

Total 𝒑.𝟏 𝒑.𝟐 𝒑.𝟑 𝒑.𝟒 𝟏 
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A acurácia global, a do produtor (por classe) e do usuário (por classe) podem ser estimadas, 

respectivamente, pelas equações 2, 3 e 4 a seguir.  

a) Acurácia Global: proporção de pixels classificados corretamente. 

 𝐴 = ∑ 𝑝𝑗𝑗

𝑞

𝑖=1

 
Equação 2 

 

b) Acuracidade do produtor para a classe 𝒋: proporção da área da referência para a classe 𝑗 que é 

mapeada como a classe 𝑗 na imagem; tem como medida complementar o erro de omissão da 

classe 𝒋, 1-  𝒑𝒋𝒋/𝒑.𝒋 

 𝑃𝑗 =
𝑝𝑗𝑗

𝑝.𝑗
 Equação 3 

 

c) Acuracidade do usuário para a classe 𝒊: proporção da área mapeada como classe 𝑖 que tem na 

referência a classe 𝑖; tem como medida complementar o erro de comissão da classe 𝒊, 1-  𝒑𝒊𝒊/𝒑𝒊. 

 𝑈𝑖 =
𝑝𝑖𝑖

𝑝𝑖.
 Equação 4 

 

O coeficiente de Kappa apresenta diversos problemas (Pontius e Millones, 2011), e sua 

utilização não é recomendada por Olofsson et al., (2014) e não deverá ser reportado.  

Com relação à acurácia global, deve ser informado seu valor e o respectivo intervalo de 

confiança, dado pela Equação 5 (Olofsson et al., 2014).  

 

a) Intervalo de confiança para a Acurácia Global 

 𝐼𝐶 =  𝐴 ± 𝑡 ∗  √𝑉̂(𝐴̂)  
Equação 5 

Em que: 

𝐴 = Acurácia global 

𝑡 = valor de t na tabela 𝑡 de Student para 95% de probabilidade (=1,96) 

𝑉̂(𝐴̂) = variância estimada para a Acurácia Global, dada pela Equação 6 
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b) Variância estimada para a Acurácia Global 

 𝑉̂(𝐴̂) = ∑ 𝑊𝑖
2𝑈̂𝑖(1 − 𝑈̂𝑖)/(𝑛𝑖. − 1)

𝑞

𝑖=1

 
Equação 6 

 

1.4. Criação de uma Rede de Pontos 

A avaliação do mapa de uso e cobertura da terra deverá ser realizada por meio de um grid de 

pontos distribuídos a cada 500 metros, estabelecido de acordo com os limites da UAP. Considerando 

que os mapas de uso e cobertura da terra das unidades amostrais de paisagem serão processados para 

uma área de 11 x 11 km, essa mesma área deverá ser adotada na criação da rede de pontos. Para a 

criação dessa rede de pontos pode-se utilizar a ferramenta “Create Fishnet” do software ArcGIS, 

localizada no diretório ArcToolbox>Data>Management Tools>Feature Class>Create Fishnet (Figura 1 

(a)). O arquivo shapefile contendo os limites da UAP corresponde aos limites do grid de pontos 

(“Template Extent”) (Figura 1 (b), item 1). Na janela da ferramenta Create Fishnet também é necessário 

indicar o tamanho da célula do grid a ser criada, ou seja, a distância entre os pontos de controle 

amostrais, e marcar a opção para a criação dos pontos (Figura 1 (b), itens 2 e 3). 

No software QuantumGIS é possível criar a mesma rede de pontos de forma similar ao 

processo previamente exposto, utilizando-se primeiro a ferramenta “Grade vetorial”, localizada na 

barra de ferramentas principal do programa, em Vetor>Investigar>Grade Vetorial e, posteriormente, 

aplicando-se a ferramenta “Centróide do Polígono”, com base na grade vetorial recém-criada, 

localizada também na barra de ferramentas principal, em Vetor>Geometrias>Centroide do Polígono. 
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(a) (b) 

Figura 1. Janelas do software ArcGIS indicando a localização da ferramenta Create Fishnet no ArcToolbox (a), bem 
como os inputs para a criação da rede de pontos (b). 

 

O processo descrito será responsável pela geração de dois arquivos shapefile, um com feições 

do tipo polígono, representando a grade vetorial composta por quadrados de 500 por 500 metros, e o 

outro com feições do tipo ponto, localizadas ao centro de cada polígono. Os 484 pontos de controle 

gerados devem ser classificados de acordo com a legenda pré-definida (Tabela 3), para avaliação e 

validação do mapa de uso e cobertura, representando a verdade de campo a ser utilizada no cálculo 

da matriz de erro e demais coeficientes de concordância. Na Figura 2 pode-se observar os arquivos 

criados pela ferramenta Create Fishnet para uma das unidades amostrais de paisagem do estado da 

Bahia. 

1 

2 

3 



 

15 

 

Figura 2. Janela do software ArcGIS exibindo a grade vetorial e os pontos de controle criados pela ferramenta 
Create Fishnet para a UAP1444, utilizando a extensão do mosaico RapidEye em composição NIR/RE/R. 

 

1.5. Classificação dos Pontos de Controle 

Para a coleta dos pontos de controle para a avaliação do mapeamento deve-se utilizar o 

arquivo de pontos gerado no processo previamente descrito. Neste arquivo deve ser criado um novo 

campo, do tipo numérico, para receber o código da classe correspondente ao ponto (Figura 3, item 1). 

Após a criação desse campo, deve-se colocar a camada em edição, clicando com o botão direito sobre 

a camada correspondente na Tabela de Conteúdos (Table of Contents, Figura 3) e selecionando a opção 

Edit Features>Start Editing, iniciando a classificação dos 484 pontos de controle. 

A primeira fonte de dados de referência consiste no próprio mosaico das imagens RapidEye 

(RE), utilizado para a elaboração do mapa de uso e cobertura. Para a coleta, deve-se identificar a classe 

contemplada por cada ponto de controle, cuja descrição pode ser consultada na Tabela 3. Na Figura 3, 
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por exemplo, estão selecionados, em azul, sete pontos de controle localizados em áreas de 

reflorestamento, devendo, então, receber o código 05. 

 

 

Figura 3. Janela do software ArcGIS exibindo pontos de controle que contemplam a classe 05 (Reflorestamento), 
selecionados em azul e destacados na tabela de atributos do arquivo de pontos.  

 

Os códigos e uma descrição sucinta de cada classe de uso e cobertura da terra podem ser 

consultados na Tabela 3. A descrição completa das classes de uso e cobertura da terra foi 

disponibilizada no manual que descreve os procedimentos para a execução do mapeamento de uso e 

cobertura da terra das Unidades Amostrais de Paisagem do IFN-BR e deve ser consultada previamente 

à avaliação da classificação de uso e cobertura da terra.  

 

 

  

1 

05 

05 

05 

05 

05 

05 

05 
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Tabela 3.  Descrição sucinta e codificação das classes de uso e cobertura da terra das UAPs do IFN-BR 
(continua...). 

Classe de Uso e 
Cobertura 

Código Descrição  

Floresta Natural 01 

Florestas são definidas, de acordo com FAO (2015), como 
áreas estendendo-se a mais do que 0,5 ha com árvores de 
mais de 5 m de altura e uma cobertura de copa maior do 
que 10%, ou árvores capazes de atingir estes limiares in situ. 
Não incluem áreas de uso predominantemente agrícola ou 
urbano. Assim, florestas são definidas tanto pela presença 
de árvores quanto pela ausência de outros usos da terra 
predominantes. 

Outras Terras com 
Vegetação Lenhosa 

02 

Conceitualmente, “Outras Terras com Vegetação Lenhosa” 
são áreas não classificadas como florestas, que se estendem 
por mais de 0,5 ha, com árvores maiores do que 5 m e 
cobertura de copas entre 5 e 10%; ou árvores capazes de 
atingir estes limiares in situ; ou com uma combinação de 
indivíduos arbóreos, arbustivos e de árvores com mais de 
10% de cobertura do dossel.  

Árvores Fora da Floresta 03 

Árvores isoladas, ou agrupadas, que não se enquadram na 
definição de floresta, são “Árvores Fora da Floresta” ou 
“TOF” (Trees Outside the Forest) – polígonos que tenham 
área superior a 0,05 ha (500m2) e inferior a 0,5 ha (5.000m2) 
(De Foresta et al., 2013).  

Gramíneas e Herbáceas 04 

Corresponde a áreas naturais caracterizadas por um estrato 
predominantemente herbáceo, com eventual ocorrência de 
elementos arbóreo/arbustivo, desde que esparsamente 
distribuídos, sobre um tapete gramíneo-lenhoso. 
Encontram-se disseminadas por diferentes regiões 
fitogeográficas, compreendendo diferentes tipologias, com 
diversos graus de antropização (IBGE, 2013). 

Floresta Plantada 05 

Classe relativa aos plantios ou formações de maciços com 
espécies florestais nativas ou exóticas, puros ou 
consorciados. Nesta definição não se considera se o plantio 
é realizado em áreas anteriormente povoadas com espécies 
florestais ou não; considera-se reflorestamento todas as 
áreas povoadas com essências florestais, 
independentemente do ambiente. 

Solo Exposto 06 

Classe que inclui áreas sem cobertura vegetal, podendo ser 
ocupada por praias fluviais, bancos de areia, atividades de 
mineração, exploração de jazidas, lavras, extração de areia, 
bem como afloramentos rochosos. Apresentam, em geral, 
coloração clara, textura lisa e forma variável. 
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Tabela 3. Descrição sucinta e codificação das classes de uso e cobertura da terra das UAPs do IFN-BR 

(... continuação). 

Classe de Uso e 
Cobertura 

Código Descrição  

Agricultura e Pastagem 07 

Engloba áreas utilizadas para a produção de alimentos, 
fibras e commodities do agronegócio, incluindo todas as 
terras cultivadas, caracterizadas pelo delineamento de 
áreas cultivadas ou em descanso, podendo também 
compreender áreas alagadas (IBGE, 2013) que sejam 
utilizadas para essa mesma finalidade. Classe constituída 
por culturas temporárias, cíclicas e permanentes. Inclui, 
ainda, as plantas hortícolas, floríferas, medicinais, 
aromáticas e condimentares de pequeno porte. Inclui 
lavouras semipermanentes e plantios lenhosos perenes, 
como os de frutíferas.  

Influência Urbana 08 

A essa nomenclatura estão associados os tipos de uso da 
terra de natureza antrópica intensiva, estruturadas por 
edificações e sistema viário, onde predominam as 
superfícies artificiais não agrícolas. Estão incluídas nesta 
categoria as metrópoles, cidades, vilas, áreas de rodovias, 
serviços e transporte, energia, comunicações e terrenos 
associados, bem como edificações presentes no meio rural 
(casas, galpões, estábulos, entre outras) 

Superfície com Água 09 

Áreas compostas pelo oceano, por rios de margem dupla, 
lagos, lagoas, barragens, represas, canais naturais ou 
artificiais, tanques d’água, com área igual ou superior a 1 
hectare.  

Área não Observada 00 

Áreas não observadas por impedimentos tais como erro no 
sistema de imageamento, obstruções como nuvens e 
sombra de nuvens e demais condições de observação 
desfavoráveis.  

 

Como ferramenta auxiliar na classificação dos pontos pode-se fazer uso das imagens 

disponíveis no Google Earth, muito úteis principalmente devido à alta resolução espacial, além de 

conter séries históricas, que permitem uma análise mais completa da dinâmica do uso e cobertura da 

terra. 

Um exemplo que ocorre com frequência diz respeito à classe “Floresta plantada” (05), na qual 

áreas temporariamente não estocadas devido ao corte raso devem ser incluídas, podendo ser 

confundidas com a classe “Solo Exposto” (06), ou mesmo “Agricultura e Pastagem” (07). Na Figura 4 

ilustra-se a seguinte situação: a UAP1444 contém predominância de áreas de reflorestamento, de 

forma que o ponto 2, quando observado somente no mosaico RapidEye (Figura 4 (a)) pode ser 

erroneamente classificado como pertencente à classe “Floresta plantada”, quando, na verdade, 

corresponde a uma área de “Agricultura e Pastagem”, facilmente identificada na imagem do Google 

Earth (Figura 4 (b)). 
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(a) 

 

(b) 

Figura 4. Exemplos de pontos de controle ocorrentes na UAP1444, localizada na Bahia, ilustrando áreas de 
reflorestamento (pontos 1 e 4), agricultura e pastagem (2), e cobertura arbórea/arbustiva (3), no 
mosaico RapidEye (5R, 4G, 3B) (a), e na imagem do GoogleEarth, relativa ao ano de 2014 (b). 

 

Outras situações que podem ocorrer em áreas de floresta plantada estão ilustradas na Figura 

5, que mostra a resposta espectral de talhões cujo corte raso foi realizado recentemente em relação à 

data de aquisição das imagens (Figura 5 (a)). A análise da série histórica das imagens do Google Earth 

revela que essa mesma área vem sendo usada há anos para este propósito (Figura 5 (d)), apresentando 

plantios ainda jovens (b) (e) e plantios maduros (c) (f). Desta forma, ainda que tenha apresentado 

cobertura formada por solo nu, a área deve ser classificada como “Floresta Plantada”.  

1 2 4 3 
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(a) (b) (c) 

   

(d) (e) (f) 

Figura 5. Exemplos de diferentes áreas pertencentes à classe “Reflorestamento”, ilustrando a resposta espectral 
da imagem RapidEye (5R, 4G, 3B) em talhões temporariamente não estocados devido ao recente corte 
raso (a), plantios jovens (b) e plantios adultos (c), bem como sua correspondência nas imagens do 
Google Earth (d)(e)(f). 

 

Por sua vez, áreas pertencentes à classe “Gramíneas e Herbáceas” (04) são particularmente de 

difícil identificação e classificação, devendo-se utilizar as imagens oriundas do Google Earth para 

elucidar quaisquer dúvidas. Na Figura 6 (a), por exemplo, a resposta espectral da vegetação presente 

nessa área pode ser classificada erroneamente como pertencente à classe “Agricultura e Pastagem” 

(07), devido ao seu porte herbáceo, com poucos elementos arbóreo-arbustivos presentes. A consulta 

às imagens do Google Earth (d) permite a correta classificação do ponto, caracterizado por áreas 

úmidas, com vegetação natural de porte herbáceo, localizada às margens de rios, alagadas 

sazonalmente (Figura 6 (b) e (e)) e várzeas (Figura 6 (c) e (f)), classificadas como “Gramíneas e 

Herbáceas”.  
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(a) (b) (c) 

   

(d) (e) (f) 

Figura 6. Exemplos de diferentes áreas pertencentes à classe “Gramíneas e Herbáceas”, ilustrando a resposta 
espectral da imagem RapidEye (5R, 4G, 3B) em localidades com presença de vegetação herbácea, com 
ocorrência esparsa de elementos arbóreo/arbustivo, devido à presença de solo raso (a), e em áreas 
úmidas (b) (c), e sua correspondência nas imagens do Google Earth (d) (e) (f). 

 

Após a classificação de todos os pontos da verdade de campo deve-se utilizar a ferramenta 

“Split by Attribute” para separar este arquivo vetorial em vários arquivos com base no campo contendo 

o código da classificação. Assim, a ferramenta irá separar todos os pontos classificados como “01”, por 

exemplo, em um shapefile contendo somente os pontos pertencentes a essa classe, e assim 

sucessivamente, para todas as classes, de forma que ao fim do processo existirá um arquivo shapefile 

para cada classe presente no mapeamento. A ferramenta citada pode ser encontrada para download 

no endereço eletrônico: http://www.umesc.usgs.gov/management/dss/split_by_attribute_tool.html.  

Conforme ilustrado na Figura 7 (a) deve-se selecionar como camada de entrada (Feature Layer) 

o arquivo vetorial contendo a classificação dos pontos de verdade de campo, e escolher o campo a ser 

utilizado para a divisão dessa camada (Split Field), bem como o prefixo para a nomenclatura dos 

arquivos que serão criados. Após a execução, um arquivo do tipo geodatabase (.gdb) será criado 

(Figura 7 (b)), contendo tantas camadas quantas forem as classes de uso e cobertura da terra 
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identificadas. Estas camadas de informação devem ser abertas no projeto do ArcGIS e exportadas para 

o formato shapefile, uma a uma. Estes arquivos correspondem às entradas dos pontos de controle 

utilizados no software ENVI para a avaliação da acurácia dos mapas de uso e cobertura da terra. Para 

realizar a exportação do arquivo de cada classe referente aos pontos de controle coletados, basta clicar 

com o botão direito na camada que se deseja exportar e selecionar a opção Data>Export Data. 

 

  

(a) (b) 

Figura 7. Janelas do software ArcGIS ilustrando a ferramenta Split By Attribute e os arquivos geodatabase criados 
por ela. 

 

No software QuantumGIS é possível realizar a mesma operação, com a ferramenta “Dividir 

Camada Vetorial”, localizada na barra de ferramentas principal, em: Vetor>Gerenciar Dados>Dividir 

Camada Vetorial. Basta selecionar o arquivo shapefile com os pontos classificados como a camada 

vetorial de entrada e escolher o campo de identificação exclusivo como sendo a coluna contendo a 

codificação da classificação, bem como uma pasta de saída para o salvamento dos arquivos, que já 

serão salvos no formato shapefile. 

1.6. Cálculo da Matriz de Erro 

O cálculo da matriz de erro para a avaliação da acurácia do mapeamento pode ser realizado 

por meio do software ENVI, na versão Classic. Por meio da barra de ferramentas principal deve-se abrir 

o arquivo raster correspondente ao mapa de uso e cobertura da terra para o qual se pretende calcular 

a acurácia, clicando em File>Open Image File.  
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Convém salientar que, conforme indicado no Manual de Análise de Paisagem - Procedimentos 

para a Execução do Mapeamento de Uso e Cobertura da Terra das UAPs do IFN-BR, após a edição do 

mapa de uso e cobertura da terra, deve ser criada nova coluna na tabela de atributos, que conterá os 

códigos variando de 00 a 09, correspondentes às classes descritas na Tabela 3. Com base neste código 

será gerado o arquivo raster correspondente ao mapa de uso e cobertura da terra, utilizado para a 

verificação da acurácia.  

Depois de carregada no software, a imagem deve ter sua legenda ajustada de acordo com as 

classes abrangidas pelo mapeamento. Para isso, deve-se acessar a ferramenta “Density Slice”, 

disponível na barra de ferramentas da imagem, em Tools>Color Mapping>Density Slice (Figura 8 (a)). 

 

(a) 

 

(b) 

 

 (c) 

Figura 8. Janelas do software ENVI Classic ilustrando o processo de preparo de uma imagem classificada para 
posterior cálculo da matriz de erro. 

 

Na janela da ferramenta “Density Slice” que irá se abrir deve-se configurar a distribuição das 

classes na legenda conforme exposto na Figura 8 (b). O intervalo de dados (Data Range) deve abranger 

todas as classes contempladas na imagem. No caso da imagem utilizada como exemplo, referente à 
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UAP1444, todas as classes de uso e cobertura da terra estão presentes, de forma que seu intervalo de 

dados varia de 01 (Min) a 09 (Max). Para cada classe deve-se definir a amplitude de valores dos pixels 

(Defined Density Slice Ranges) de acordo com os códigos de classes, variando de 1 a 1 para a primeira 

classe, de 2 a 2 para a segunda classe (02) e assim por diante. Após a configuração correta de todas as 

classes, deve-se aplicar as edições (Apply) e exportar a imagem classificada com o novo intervalo de 

dados em File>Output Ranges to Class Image (Figura 8 (c)). 

Para facilitar a visualização de cada classe, e posterior análise da matriz de erro que será 

gerada, os nomes das camadas presentes na nova imagem podem ser editados, representando as 

diferentes classes do mapeamento, que variam de 201 a 209. Para isso, por meio da barra de 

ferramentas da imagem pode-se acessar a janela “Class Color Mapping”, em Tools>Color 

Mapping>Class Color Mapping, e editar o nome das camadas do raster. 

Após preparada a imagem para a qual será calculada a matriz de erro, deve-se adicionar os 

arquivos de pontos previamente classificados que representarão a verdade de campo (referência) na 

análise. Na barra de ferramentas principal do software deve-se clicar em Vector>Open Vector File e 

abrir o conjunto de arquivos shapefile contendo os pontos. Esses pontos também podem ter seus 

nomes editados para melhor visualização e análise da matriz de erro, em Options/Edit Layer Names na 

janela que será aberta quando os arquivos vetoriais forem carregados. Em seguida, deve-se exportar 

os arquivos vetoriais, em File>Export Layers to ROI (Figura 9 (a)), selecionando-se a opção para 

conversão de todos os registros da camada para ROI (Convert all records of an EVF layer to one ROI) 

(Figura 9 (b)). 
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(a) (b) 

Figura 9. Janelas do software ENVI Classic ilustrando o processo de preparo dos pontos de controle 
representando a verdade de campo para posterior cálculo da matriz de erro. 

 

Com os dados preparados pode-se proceder à elaboração da matriz de erro. Na barra de 

ferramentas principal do software clicar em Classification>Post Classification>Confusion Matrix>Using 

Ground Truth ROIs (Figura 10 (a)). Na janela que se abre (Match Classes Parameters) devem ser 

selecionados os pontos de verdade de campo e da imagem correspondentes a cada classe e clicar em 

“Add Combination”, da mesma maneira como ilustrado na Figura 10 (b). Na janela “Confusion Matrix 

Parameters”, selecionar as opções para que a matriz contenha dados tanto em pixels quanto em 

percentuais, bem como a opção “Report Accuracy Assessment” (Figura 10 (c)). 
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(a) 

 

 

(c) 

(b) 
 

Figura 10. Janelas do software ENVI Classic ilustrando o processo de cálculo de uma matriz de erro a partir de 
pontos da verdade de campo. 

 

Desta forma, o arquivo de saída gerado apresenta a acurácia global, o coeficiente Kappa, a 

matriz de erro em termos de pixels e também em termos percentuais, bem como os erros de comissão 

e omissão de cada classe, a acuracidade do produtor e a acuracidade do usuário de cada classe. Na 

Figura 11 são apresentadas as matrizes de erro geradas para uma determinada UAP, com resultados 

tanto em pixels (a) quanto em valores percentuais (b), bem como a acurácia global e o valor do 

coeficiente de Kappa.  
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(a) 

 

(b) 

Figura 11. Matrizes de erro geradas por meio do software ENVI, referentes à avaliação da acuracidade do mapa 
de uso e cobertura da terra para a UAP1444, localizada na Bahia, em valores absolutos (a) e em valores 
percentuais (b). 

 

Por sua vez, a distribuição percentual de pixels classificados de forma correta com relação ao 

número total de pixels de referência é representada pela acurácia global, que no caso da UAP 

exemplificada, foi de aproximadamente 90%, de forma que de um total de 494 pixels, 447 foram 

classificados corretamente. Na Figura 12 (a) são apresentados os valores de comissão, omissão em 

pixels e em percentuais e na Figura 12 (b) a acuracidade do produtor e do usuário por classe, 

também em pixels e em percentuais. 

A matriz de erros gerada pelo software ENVI servirá de base para a construção da matriz de 

erros em termos de proporção de área (Tabela 2), a partir da qual deverão ser calculados e 

apresentados os valores da acurácia global proporcional à área e sua respectiva variância estimada, de 

acordo com a formulação apresentada na Seção 1.3, Análise e Estimativa dos Resultados.  
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(a) 

 

(b) 

Figura 12. Coeficientes de concordância gerados pelo software ENVI, referentes aos erros de comissão e omissão 
das classes de uso e cobertura da terra (a), bem como os valores de acuracidade do produtor e do 
usuário (b), em valores percentuais e em pixels. 

 

Apresenta-se a seguir um exemplo do cálculo da matriz de acurácia proporcional à área, 

contendo os valores das classes, a acurácia global, a acuracidade do produtor e do usuário por classe, 

bem como o intervalo de confiança a 95% de probabilidade para a acurácia global (proporcional à área) 

e sua respectiva variância estimada, utilizando os dados da UAP1214, localizada no município de 

Paranaguá-PR. 
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Tabela 4.  Número de polígonos e superfícies absoluta e percentual ocupadas pelas classes de uso e cobertura 
da terra, calculadas a partir do mapeamento na área de abrangência de 11x11Km, na projeção UTM, 
Fuso 22S, WGS84, para a UAP1214. 

Classe Número de polígonos Área (ha) Área (%) Wi 

1 138 7962,64 65,81 0,6581 

2 0 0,00 0,00 0,0000 

3 59 14,40 0,12 0,0012 

4 156 764,02 6,31 0,0631 

5 0 0,00 0,00 0,0000 

6 43 43,91 0,36 0,0036 

7 225 854,04 7,06 0,0706 

8 90 1538,18 12,71 0,1271 

9 82 922,80 7,63 0,0763 

Total 793 12100,00 100,00 1,0000 

 

Tabela 5.  Matriz de confusão referente à avaliação da acuracidade do mapa de uso e cobertura da terra em 
pixels, para a UAP1214. 

Classe 
Dados de referência (“verdade de campo”) em pixels Total 

(ni.) 1 4 6 7 8 9 

1 272 15 0 3 11 0 301 

4 4 22 0 0 1 0 27 

6 0 0 1 0 2 0 3 

7 6 0 0 26 9 1 42 

8 3 0 0 3 64 2 72 

9 2 4 0 0 0 33 39 

Total 

(n.j) 
287 41 1 32 87 36 484 
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Para o cálculo dos valores da matriz de erro ponderada pela proporção de área para cada classe 

de uso e cobertura da terra, deve-se utilizar a Equação 1. A sequência de cálculos apresentada a seguir 

exemplifica a obtenção de 𝑝̂11 para a Classe 1. Os valores utilizados no cálculo aparecem destacados 

em azul na Tabela 4 e na Tabela 5.  

𝑝̂𝑖𝑗 = 𝑊𝑖  
𝑛𝑖𝑗

𝑛𝑖.
  →  𝑝̂11 = 0,6581 ∗ 272 301⁄  →  𝒑̂𝟏𝟏 = 𝟎, 𝟓𝟗𝟒𝟕 

 

Na Tabela 6 são apresentados os resultados do cálculo dos valores da matriz de 𝑝̂𝑖𝑗, bem como 

o somatório das linhas e colunas.  

 

Tabela 6.  Matriz de erro ponderada pela proporção de área estimada para cada classe de uso e cobertura da 
terra, para a UAP1214. 

Classe 

Dados de referência (“verdade de campo”) ponderados pela proporção de 

área da classe Total 

(pi.) 
1 4 6 7 8 9 

1 0,5947 0,0328 0,0000 0,0066 0,0240 0,0000 0,6581 

4 0,0094 0,0514 0,0000 0,0000 0,0023 0,0000 0,0631 

6 0,0000 0,0000 0,0012 0,0000 0,0024 0,0000 0,0036 

7 0,0101 0,0000 0,0000 0,0437 0,0151 0,0017 0,0706 

8 0,0053 0,0000 0,0000 0,0053 0,1130 0,0035 0,1271 

9 0,0039 0,0078 0,0000 0,0000 0,0000 0,0645 0,0763 

Total 

(p.j) 
0,6233 0,0921 0,0012 0,0555 0,1569 0,0697  

 

 

A partir dessa matriz deve-se calcular a Acurácia Global (𝐴), as acurácias do Produtor (𝑃𝑖) e do 

Usuário (𝑈𝑖) por classe, proporcionais à área. A Acurácia Global é dada pela Equação 2, e corresponde 

ao somatório da diagonal principal da matriz de erro representada pela Tabela 6, onde os valores foram 

destacados em azul, conforme demonstrado a seguir: 
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𝐴 = ∑ 𝑝𝑗𝑗

𝑞

𝑖=1

 → 𝐴 =  0,5947 + 0,0514 +  0,0012 +  0,0437 +  0,1130 +  0,0645 

𝐀 = 𝟎, 𝟖𝟔𝟖𝟓 

 

O cálculo da acurácia do Produtor (Equação 3) e do Usuário (Equação 4) para a Classe 1 está 

exemplificada na sequência: 

 

𝑃𝑗 =
𝑝𝑗𝑗

𝑝.𝑗
 →  𝑃1 =  0,5947 0,6233⁄  →  𝑷𝟏 = 𝟎, 𝟗𝟎𝟑𝟕 

𝑈𝑖 =
𝑝𝑖𝑖

𝑝𝑖.
 →   𝑈1 =  0,5947 0,6581⁄  →  𝑼𝟏 = 𝟎, 𝟗𝟓𝟒𝟎 

 

Os resultados do cálculo dos valores de acurácia do produtor e do usuário, proporcionais à 

área, estão apresentados na Tabela 7. 

Tabela 7.  Acurácias do produtor e do usuário ponderadas pela área, por classe de uso e cobertura da terra. 

Classe Acurácia do Produtor 

(Pj) 

Acurácia do Usuário 

(Ui) 

1 0,9540 0,9037 

4 0,558 0,8148 

6 1,0000 0,3333 

7 0,7866 0,6190 

8 0,7201 0,8889 

9 0,9253 0,8462 

 

Também deve ser apresentada Variância Estimada (𝑉̂(𝐴̂)) da Acurácia Global ponderada pela 

proporção de área de cada classe. O cálculo para a Variância, obtida a partir da Equação 6, está 

demonstrado na sequência: 

𝑉̂(𝐴̂) = ∑
𝑊𝑖

2𝑈̂𝑖(1 − 𝑈̂𝑖)

𝑛𝑖. − 1

𝑞

𝑖=1
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                  𝑉̂(𝐴̂) =  
0,65812 ∗ 0,9037(1 − 0,9037)

(301 − 1)
+ 0,00002314 + 0,000001464 

+0,00002866 + 0,00002245 + 0,00001992 

𝑽̂(𝑨̂) = 𝟎, 𝟎𝟎𝟎𝟐𝟐𝟏𝟑𝟑𝟖 

 

A partir da Variância deve ser calculado o Intervalo de Confiança (I.C.) (Equação 5) de 95% de 

probabilidade para a Acurácia Global ponderada pela proporção de área de cada classe. 

 

𝐼𝐶 =  𝐴 ± 𝑡 ∗ √𝑉̂(𝐴̂) → 𝐼𝐶 = 0,8685 ± 1,96 ∗ √0,0002213  → 𝑰𝑪 = 𝟎, 𝟖𝟔𝟖𝟓 ± 𝟎, 𝟎𝟐𝟗𝟏𝟔 

 

Desta forma, o Intervalo de confiança da acurácia global (proporcional à área) do mapeamento 

de uso e cobertura da terra da UAP 1214 resulta em: 

𝑰𝑪𝒂𝒄𝒖𝒓á𝒄𝒊𝒂 𝒈𝒍𝒐𝒃𝒂𝒍 = [𝟖𝟑, 𝟗𝟒;  𝟖𝟗, 𝟕𝟕] 

 

Deve ser apresentado ao SFB um relatório contendo, para cada UAP: 

- Matriz de acurácia em pixels, contendo os valores das classes, a acurácia global, a acuracidade 

do produtor e do usuário por classe.  

- Matriz de acurácia em valores percentuais do número de pixels, contendo os valores das 

classes, a acurácia global, a acuracidade do produtor e do usuário por classe. 

- Matriz de acurácia proporcional à área, contendo os valores das classes, a acurácia global, a 

acuracidade do produtor e do usuário por classe. 

- O intervalo de confiança a 95% de probabilidade para a acurácia global (proporcional à área) 

e sua respectiva variância estimada.  
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1.7. Critérios quantitativos e qualitativos para a avaliação do produto 

Especificar uma única medida para todos os fins de avaliação da acurácia da classificação, 

apesar de ser o desejado, não é possível, pois um único coeficiente não é capaz de fornecer uma 

avaliação satisfatória quanto à qualidade de uma classificação (Foody, 2002). Assim, recomenda-se 

que, ao invés de simplesmente fornecer um coeficiente básico para avaliação da acurácia da 

classificação de imagens (como, por exemplo, o índice percentual de acurácia global de cada classe), 

sejam adotadas mais medidas de acurácia, além de fornecer a matriz de erro como uma descrição mais 

completa da qualidade da classificação. 

Além disso, nas avaliações clássicas de acurácia de mapas temáticos, todas as atribuições 

incorretas têm o mesmo peso. Muitas vezes, no entanto, alguns erros são mais importantes, ou 

prejudiciais, do que outros. Em muitos casos, erros observados em uma classificação ocorrem entre 

classes similares e, por vezes, podem não ter importância para o produto final, enquanto outros podem 

ser muito significativos (Foody, 2002). Considerando que as classes temáticas mais importantes no IFN-

BR, tanto para o mapa de uso e cobertura da terra quanto para as análises de paisagem a serem 

realizadas com esse produto são as classes com cobertura arbórea/arbustiva (“Floresta Natural”, 

“Floresta Plantada”, “Outras Terras com Vegetação Lenhosa” e “Árvores fora da Floresta”) e as áreas 

de ocorrência de campos naturais (“Gramíneas e Herbáceas”), percentuais de acerto mais elevados 

para essas classes são desejados. De menor relevância, por exemplo, é o erro entre as classes de 

“Influência Urbana“ e “Solo Exposto”.  

Desta forma, é adotado um limiar mínimo de 80% de acurácia global e limiares de 60% na 

acurácia do produtor e usuário para as classes de cobertura arbórea/arbustiva (“Floresta Natural”, 

“Floresta Plantada”, “Outras Terras com Vegetação Lenhosa” e “Árvores fora da Floresta”), dada sua 

importância, e de 50% na acurácia do produtor e usuário para a classe de campo natural (“Gramíneas 

e Herbáceas”), dada a dificuldade em seu reconhecimento e classificação, salvo nos casos em que a 

ocorrência da classe na UAP for inferior a 5%. Um resumo destes valores é apresentado na Tabela 8, a 

seguir. 
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Tabela 8. Valores de referência para a acurácia da classificação do uso e cobertura da terra nas Unidades 
Amostrais de Paisagem do IFN-BR.  

Acurácia (%) 

Geral 80 

Floresta Natural (produtor e usuário) 

Floresta Plantada (produtor e usuário) 

Outras Terras com Vegetação Lenhosa (produtor e usuário) 

Árvores fora da Floresta (produtor e usuário) 

60 

Gramíneas e herbáceas 50 

 

Além dos coeficientes acima expostos, que correspondem aos critérios quantitativos para a 

avaliação do produto, recomenda-se uma avaliação também qualitativa, baseada simplesmente na 

interpretação visual do mapeamento realizado com base no mosaico RapidEye, pois, muitas vezes, 

apesar de os coeficientes apresentarem resultados aparentemente satisfatórios, basta uma breve 

conferência visual da classificação gerada para que erros sejam encontrados, e facilmente corrigidos, 

como exposto na Figura 13. Esta etapa de análise visual também garante que áreas que não 

correspondem às amostradas pelo grid de pontos de controle sejam controladas.  

Para execução de tal conferência, o Google Earth também pode ser utilizado como ferramenta 

auxiliar. Recomenda-se, ainda, considerando a resolução espacial do mosaico RapidEye, uma escala de 

trabalho de 1:5.000, e a utilização da grade vetorial de 500 x 500m criada previamente para geração 

dos pontos de controle, como guia para garantir que toda a cobertura da imagem passe por essa 

avalição qualitativa, na forma de uma varredura sistemática.  

 



 

35 

 

Figura 13. Janela do software ArcGIS ilustrando a escala que deve ser utilizada para a avaliação qualitativa do 
mapa de uso e cobertura, bem como um erro de atribuição entre as classes, apontado pela seta em 
vermelho, onde um polígono que deveria ser classificado como pertencente à classe “Floresta 
plantada” (05), recebeu atribuição da classe “Floresta Natural”. 
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1.8. Auditoria dos Lotes de Mapas de Uso e Cobertura da terra 

Os lotes de mapas de uso e cobertura da terra das Unidades Amostrais de Paisagem do IFN-BR 

elaborados por empresas privadas serão avaliados por uma equipe determinada pelo SFB para esta 

atividade. Desta forma, uma avaliação nova e independente será realizada como forma de auditoria 

dos produtos recebidos pelo SFB, constituindo a etapa final do controle de qualidade.  

Um percentual inicial de 10% dos mapas de cada lote recebido terão avaliação de acurácia 

elaborada por um intérprete da equipe determinada pelo SFB, portanto independente da avaliação 

realizada pela empresa. As UAPs serão amostradas por seleção aleatória e um novo grid amostral será 

definido. Um intérprete deverá rotular os pontos de controle deste novo grid amostral e uma nova 

avaliação da acurácia será gerada. Os valores de acurácia obtidos na auditoria devem estar dentro dos 

limites de aprovação dos produtos e dentro do intervalo de confiança de 95% calculado.  
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